Exercise 3  Adding words to the Custom Spelling Dictionary................................. 30
Exercise 4  Adding a phonetic replacement......................................................... 31
Exercise 5  View your Spelling Log................................................................... 32
Learning Check List........................................................................................... 33

10. Using the Sounds Like and Confusable Words ............................................ 34
Exercise 1  Identifying like sounding and confusable words........................... 34
Exercise 2  Changing the colour used to identify homophones....................... 36
Exercise 3  Editing the Sounds Like and Confusable Words database............ 37
Exercise 4  Returning Always Ignored words.................................................... 38
Learning Check List........................................................................................... 38

11. Predicting text................................................................................................. 39
Exercise 1  Using the Prediction facility ............................................................... 39
Exercise 2  Adding your own Word Banksa........................................................ 40
Learning Check List........................................................................................... 41

12. Using the Dictionaries .................................................................................... 42
Exercise 1  Using the Dictionary ......................................................................... 42
Exercise 2  Using the alternative searches......................................................... 43
Exercise 3  Searching for web definitions ........................................................... 43
Exercise 4  Using the Picture Dictionary............................................................... 44
Exercise 5  Adding user definitions .................................................................... 45
Learning Check List........................................................................................... 45

13. Using the Verb Checker ................................................................................ 46
Exercise 1  Using the Verb Checker ................................................................... 46
Learning Check List........................................................................................... 47

14. Using the Scanning facility ............................................................................ 48
Exercise 1  Performing a Scan............................................................................. 48
Exercise 2  Scanning multiple documents............................................................ 50
Exercise 3  Scanning from a file ......................................................................... 51
Learning Check List........................................................................................... 52

15. Using the Fact Finder....................................................................................... 53
Exercise 1  Searching for facts using the Fact Finder ......................................... 53
Exercise 2  Changing the default website to search for facts............................. 54
Learning Check List........................................................................................... 54

16. Using the Fact Folder ...................................................................................... 55
Exercise 1  Adding text facts................................................................................ 55
Exercise 2  Adding images................................................................................... 56
Exercise 3  Changing fact details and properties................................................ 57
Exercise 4  Exporting facts from the Fact Folder................................................... 58
17. **Using the Fact Mapper** ................................................................. 60
   - Exercise 1  Working with the Fact Mapper .................................. 60
   - Exercise 2  Creating fact maps .................................................. 61
   - Exercise 3  Adding notes to facts .............................................. 62
   - Exercise 4  Using the Image Library ......................................... 63
   - Exercise 5  Adding your own images ....................................... 64
   - Exercise 6  Linking facts .......................................................... 64
   - Exercise 7  Changing how a Fact Map is displayed .................... 65
   - Exercise 8  Brainstorming ....................................................... 66
   - Exercise 9  Exporting fact maps .............................................. 67
   - Exercise 10 Printing, Saving and Opening Fact Maps ............... 67

18. **Using Screen Masking** ............................................................ 69
   - Exercise 1  Using Screen Masking ........................................... 69
   - Exercise 2  Changing the display options ................................ 69
   - Exercise 3  Using the spotlight ............................................... 70

19. **Using the Translator** .............................................................. 72
   - Exercise 1  Translating single English words into another language .. 72
   - Exercise 2  Translating paragraphs of text into another language  .. 73

20. **Using Study Skills Highlighters** ............................................ 75
   - Exercise 1  Collecting text for your studies .............................. 75

21. **Vocabulary** ............................................................................. 77
   - Exercise 1  Creating a vocabulary list for your studies .............. 77

22. **Using the Calculators** .............................................................. 79
   - Exercise 1  Using the Standard Calculator ............................... 79
Read&Write Gold for Mac is designed to provide help to users of Apple Macintosh computers, with reading and writing difficulties. It can read text aloud and help you construct words and sentences. It also has many other features such as advanced spell checking, word prediction and Internet tools, to name but a few.

This guide is designed to familiarise you with all aspects of the system. As well as learning how to use the many facilities offered in Read&Write Gold for Mac, you will also learn how to set up the system so that it will operate in exactly the way you want it to.

The exercises are colour coded and divided into:

1. **Basic Exercises** – these exercises will help you learn all of the basic skills you need to set up and use the different Read&Write Gold for Mac facilities

2. **Further Exercises** – these exercises will show additional functions that can be used.
1. **INTRODUCTION**

You can use Read&Write Gold for Mac with text within Microsoft Word, Safari, Chrome, Firefox and Google Docs. The majority of the exercises in this section explain how to use the toolbar in Microsoft Word 2011.

The Read&Write Gold for Mac facilities available to use on the toolbar are as follows:

- Text Reading
- Spell Check
- Word Prediction
- Dictionary
- Picture Dictionary
- Sounds Like and Confusable Words
- Verb Checker
- Screenshot Reader
- Speech Maker
- Daisy Reader
- Scanning
- Fact Finder
- Fact Folder
- Fact Mapper
- Screen Masking
- PDF Aloud
- Translator
- Study Skills
- Vocabulary
- Calculator
2. **THE TOOLBAR**

In this section you will learn how to:
- start Read&Write Gold for Mac
- customise the toolbar.

**Exercise 1  Starting Read&Write Gold for Mac**

1. You start Read&Write Gold for Mac from **Applications**.
2. Alternatively, if available, you can double click on the shortcut on your desktop:

   ![Shortcut](image1)

   Or click on the ![Dock icon](image2) in the dock bar.

3. The window below may appear. At this stage just click **No**.

   ![Window](image3)

4. The toolbar will open:

   ![Toolbar](image4)

5. You can move the Toolbar by clicking anywhere, except on an icon, and then dragging and releasing it onto any position on your screen.

6. You can dock the toolbar to the top by clicking on the **Title bar** of the toolbar and dragging it to the top of the screen. Now when you open any application it will appear below the Read&Write Gold for Mac toolbar.

7. Notice that the **Menu bar** at the very top of your screen has other Read&Write Gold options:

   ![Menu bar](image5)
Exercise 2  Understanding the Toolbar

1. Hover your mouse over the icon. You will see the tooltip ‘Spell Check’. Hover your mouse over the icon. You will see the tooltip ‘Dictionary’. From now on, if you have difficulty remembering what a button does, hover your mouse over it to see the tooltip.

2. The following table explains what each button on the toolbar does. Simply hover over each icon to see the tooltip.

<table>
<thead>
<tr>
<th>Spell Check</th>
<th>Sounds Like and Confusible Words</th>
<th>Prediction</th>
<th>Dictionary</th>
<th>Picture Dictionary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verb Checker</td>
<td>Play</td>
<td>Pause</td>
<td>Stop</td>
<td>Screenshot Reader</td>
</tr>
<tr>
<td>Speech Maker</td>
<td>Scan</td>
<td>Fact Folder</td>
<td>Fact Mapper</td>
<td>Translator</td>
</tr>
<tr>
<td>Screen Masking</td>
<td>PDF Aloud</td>
<td>Highlight Green</td>
<td>Highlight Pink</td>
<td>Clear Highlights</td>
</tr>
<tr>
<td>Collect Highlights</td>
<td>Vocabulary</td>
<td>Preferences</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Other icons not on the default toolbar:

<table>
<thead>
<tr>
<th>Daisy Reader</th>
<th>Rewind</th>
<th>Forward</th>
<th>Fact Finder</th>
<th>Highlight Blue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlight Yellow</td>
<td>Calculator</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Click on Mode in the menu bar. You have the option to change to a different mode depending on what you are doing:
The five modes are:

- **Speech** - only icons associated with speech are displayed on the toolbar
- **Reading** - only icons associated with reading are displayed on the toolbar
- **Writing** - only icons associated with writing are displayed on the toolbar
- **Study Skills** - only icons associated with Study Skills are displayed on the toolbar
- **Research** - only icons associated with researching are displayed on the toolbar
- **Default** - the icons for all the main features in the software are displayed on the toolbar

**What else can you do:**

- Change what icons appear on the toolbar – [Changing the icons on the toolbar](#).
- Change the size and look of the icons – [Changing the size and look of the icons](#).

**Further Exercises**

**Exercise 3  Changing the icons on the toolbar**

In this exercise you will learn how to change what icons are displayed on the Read&Write Gold for Mac Toolbar.

1. Click on View in the Read&Write Gold for Mac Menu Bar and select **Customize Toolbar**...

2. The **Customize Toolbar** panel appears:

3. Click and drag the **Daisy Reader** icon onto the toolbar above. The **Daisy Reader** icon is now on the toolbar.

4. Select the **Dictionary** in the toolbar and drag it off. The **Dictionary** icon is removed from the toolbar.

5. Click and drag the **Fact Finder** icon onto the toolbar above. The **Fact Finder** icon is now on the toolbar.
6. Select the **Scan** in the toolbar and drag it off. The **Scan** icon is removed from the toolbar.

7. Click and drag the **Screen Masking** icon to the left on the toolbar. This is how you can alter where the icons appear.

8. By using this method you can alter the toolbar so that it has all the icons you need.

9. To return the toolbar back to the way it was before this exercise click and drag the default set onto the toolbar above.

**Exercise 4**  
**Changing the size and look for the icons**

1. Click on the **Show** dropdown and select **Icon and Text**.

   ![Toolbar Icons](image)

   **Show dropdown**

   **Use small size check box**

2. The icons on the toolbar change to having the icon and the name of the icon underneath.

3. Click on the **Show** dropdown and select **Text Only**.

4. The icons on the toolbar change to having the name of the icon.

5. Click on the **Show** dropdown and select **Icon Only**.

6. The icons on the toolbar change to having the icon only.

7. Click on the **Show** dropdown and select which option you prefer.

8. Check the **Use small size** box. The icons change to a smaller size.

9. Uncheck the **Use small size** box. The icons change to a larger size.

10. Choose the option you prefer.

11. Click on **Done** to close the **Customize Toolbar** panel.
# Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to start Read&amp;Write Gold for Mac</td>
<td></td>
</tr>
<tr>
<td>How to position the Read&amp;Write Gold for Mac toolbar</td>
<td></td>
</tr>
<tr>
<td>What the buttons on the Read&amp;Write Gold for Mac toolbar are</td>
<td></td>
</tr>
<tr>
<td>How to customise the icons on the toolbar</td>
<td></td>
</tr>
</tbody>
</table>
3. **READING TEXT**

In this section you will learn how to:
- read text using text to speech in documents
- change the voice
- specify how you would like words pronounced
- set up speech highlighting.

**Exercise 1  Reading text in documents**

Open a Word document with some text in it or type the following text into a blank Microsoft Word document:

*A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases. An example of a volcano is Mount Rinjani. This volcano is found on the island of Lombok. It has a long history of eruptions and erupted in 1994 and more recently in May 2010. Volcanoes can cause major destruction.*

It is recommended that you save this document as you will use it later in the guide.

Remember to check that your sound is enabled!

1. Place your cursor anywhere on the following sentence and then click on the button:

   ‘A volcano tends to occur where tectonic plates meet.’
   
   You see each word in the sentence highlighted as it is read aloud.

2. You can also instruct the system to pause and resume reading by clicking on and off the button or stop it completely by clicking on the button.
Exercise 2  Changing the Voice

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Speech tab of the Preferences window:

3. Click on Edit Voice Settings. This will open the Text to Speech tab of your System Preferences:

4. Select a different voice from the System Voice drop down list.
5. Click on the Play button to hear the new voice read aloud. If you don’t like the voice select another.
6. You can change the Speed of the voice if you need to by dragging and dropping the Speaking Rate track bar.
7. Click on the Play button to test the voice.
8. Close the Text to Speech window.

Other voices can be downloaded by clicking on Customize in the System Voice dropdown in the Text to Speech window.
You can download further voices from the Texthelp Essentials website.

What else can you do:
- Change how words are pronounced – Changing how words are pronounced.
- Have the text read as you type – Instructing the system to read as you type.
- Change how the text is highlighted – Changing the speech highlighting.

Further Exercises

Exercise 3 Changing how words are pronounced

There may be occasions when the software does not pronounce a word correctly. In this exercise you will learn how to correct the pronunciation of a word.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Speech tab of the Preferences window and click on the + button:

   ![Preference window with Speech tab selected](image)

3. Type the word **Angeline** into the Spelling text box.
4. Type **Anjelene** into the Pronunciation text box.
5. Click on the Listen to Selected Pronunciation button to hear the new pronunciation read aloud. This is the correct pronunciation of the word.
6. This word is added to the Pronunciations list. The word will be pronounced correctly from now on.
7. Click on Close to close the Preferences.
Exercise 4  Instructing the system to read as you type

You may want to have the software read as you are typing. In this exercise you will learn how to set up the system to read letters, words and sentences as you type.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Speech tab of the Preferences window:

3. Select the Speak As I Type check box and then select from:
   - Speak by letter check box.
   - Speak by word check box
   - Speak by sentence check box.
4. Click on the Close button to save the settings and to close the Preferences window.
5. Place your cursor after the text you have already typed and type some text slowly. As you do so, the text will be read aloud.
6. If you wish to turn this option off return to the Preferences – Speech and deselect the Speak As I Type check box.
Exercise 5  Changing the Speech Highlighting

The system highlights the text in the document as it is being read. It uses the colours blue and yellow. You may wish to change this. In this exercise you will learn how to alter the highlighting colours.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Appearance tab of the Preferences window:

3. Click on the Speech Foreground Color button and select a colour from the colour palette to specify the colour of the word that is read aloud.
4. Click on the Speech Background Color button and select a colour from the colour palette to specify the background colour of the text (sentence/paragraph) that is read aloud.
5. You will see how your text will be highlighted as it is read in the Example box.
6. Click on Close when you have the colours you wish to use.

🔍 You can easily return to the default colour by clicking on Restore to Default.
# Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have a document read</td>
<td></td>
</tr>
<tr>
<td>How to change the voice</td>
<td></td>
</tr>
<tr>
<td>How to change the pronunciation</td>
<td></td>
</tr>
<tr>
<td>How to have the software read as it is typed</td>
<td></td>
</tr>
<tr>
<td>How to change how the software highlights text as it is being read</td>
<td></td>
</tr>
</tbody>
</table>
4. READING TEXT IN WEB PAGES

In this section you will learn how to:
• read information on web pages
• change the colours used when highlighting.

Exercise 1  Reading information on web pages

In this exercise you will learn how to use Read the Web to read aloud text and screen items on web pages.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Speech tab of the Preferences window:

3. Click in the Read the Web check box.
4. Click on Close.
5. Open the Safari Browser and type ‘www.texthelp.com’ into the Address field to display the Texthelp homepage.
6. Click on Install Now when prompted and then Install. Restart your Safari Browser.

You will only need to do this the first time you use Safari with Read&Write Gold for Mac.

Exercise 2  Reading webpages in Firefox

1. Open your Firefox browser and type ‘www.texthelp.com’ into the Address field to display the Texthelp homepage.
2. Click on Install Now when prompted and again click Install Now to install the plug-in.
3. Restart Firefox.
You will only need to do this the first time you use Firefox with Read&Write Gold for Mac.

4. Click anywhere on the webpage then hover your mouse over an area of text in order to read it aloud. You can use the other Speech buttons on the toolbar to stop, pause or read the previous or next text aloud.

Exercise 3  Reading webpages in Chrome

1. Open Google Chrome and type ‘www.texthelp.com’ into the Address field to display the Texthelp homepage.
2. Click on Install Now when prompted to install.
3. Click on Add.
4. Restart Chrome.

You will only need to do this the first time you use Chrome with Read&Write Gold for Mac.

5. Click anywhere on the webpage then hover your mouse over an area of text in order to read it aloud. You can use the other Speech buttons on the toolbar to stop, pause or read the previous or next text aloud.

You can still read website content aloud by selecting text and then clicking on the Read the Web button. You can also use the other Speech buttons using this method. Read the Web simply allows you to hover your mouse over the text in order to read it aloud.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>☑</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have a webpage read in Safari using Read the Web</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to have a webpage read in Firefox using Read the Web</td>
<td></td>
<td></td>
</tr>
<tr>
<td>How to have a webpage read in Chrome using Read the Web</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5. **SCREENSHOT READER**

In this section you will learn how to:
- read text in image files
- screenshot to MS Word
- change the Screenshot Reader options.

**Exercise 1  **Reading text on images

In this exercise you will learn how to use Screenshot Reader to read aloud text used in images.

- The Screenshot Reader can be used with inaccessible Flash and locked PDF documents as well as images.

1. Open the Texthelp webpage [www.texthelp.com/uk/training-screenshot](http://www.texthelp.com/uk/training-screenshot) in your Internet browser window.

2. Click on the button. Your cursor now looks like this +.

3. Click and hold your left mouse button on the top left-hand corner of the picture, then drag and drop the rectangle to the bottom right-hand corner. After a moment Read&Write Gold for Mac reads the text aloud:

![Picture of text being read aloud]

If you wish the text re-read click on the button that has appeared within the picture.

- The highlighting colour is the colour that is set as the **Speech Background Color** in the **Appearance** tab of the **Preferences** window.

4. Click on the to close the Screenshot Reader window.
Exercise 2  Screenshot to Microsoft Word

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Screenshot tab of the Preferences window:

3. Click on the Output Screenshot To dropdown and select Microsoft Word.
4. Close the Preferences.
5. Click on the button. Your cursor now looks like this +.
6. Click and hold your left mouse button on the top left-hand corner of the picture, then drag and drop the rectangle to the bottom right-hand corner.
7. Screenshot Reader will create a new Microsoft Word document and put the text in.

You will be able to use the other Read&Write Gold for Mac facilities on the text imported into Microsoft Word.

8. Save and close the Microsoft Word document when you have finished.

What else can you do:
- Change the Screenshot Reader options – Change the Screenshot Reader options.

Further Exercises

Exercise 3  Change the Screenshot Reader Options

You can change how the text is highlighted by the Screenshot Reader.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Screenshot tab of the Preferences window:
3. Click on the **Output Screenshot To** dropdown and select **Screen**.
4. Select the **Use outline highlighting** radio button.
5. Select **5** from the **Outline Weight** drop down list.
6. Click on the **Close** button.
7. Click on the button. Your cursor now looks like this +.
8. Click and hold your left mouse button on the top left-hand corner of the picture, then drag and drop the rectangle to the bottom right-hand corner.
9. Read&Write Gold for Mac reads the text aloud using the settings you have just selected.

acement colour is the colour that is set as the **Speech Foreground Color** in the **Appearance** tab of the **Preferences** window.

10. Click on the to close the Screenshot Reader window.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Screenshot in the window</td>
<td></td>
</tr>
<tr>
<td>How to Screenshot to MS Word</td>
<td></td>
</tr>
<tr>
<td>How to change the Screenshot Reader options</td>
<td></td>
</tr>
</tbody>
</table>
6. SPEECH MAKER

In this section you will learn how to:
- convert text into sound files.

It is possible to convert your text into a sound file using Read&Write Gold for Mac. Once converted the sound file can be put onto an audio device such as an iPod, MP3 player or smart phone and listened to when and where you wish.

Exercise 1  Creating sound files from text

1. Highlight the following text in your document:

   A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases. An example of a volcano is Mount Rinjani. This volcano is found on the island of Lombok. It has a long history of eruptions and erupted in 1994 and more recently in May 2010. Volcanoes can cause major destruction.

2. Click on the button on the toolbar.

   The highlighted text is displayed in the first window of the Speech Maker facility:

   ![Speech Maker window](image)

   You can type into this window if you wish to add further text or delete unwanted text.
3. Click on the **Next** button. You will see the second window in the **Speech Maker** facility:

4. Select one of the voices from the **Selected Voice** drop down list and then drag and drop the following track bars:
   - **Speed** – drag this track bar slightly to the left to slow the voice down.
   - **Volume** – drag this track bar to the left to decrease the volume or to the right to increase the volume.

5. Click on the **Test voice** button to hear what the voice will sound like. If you decide that you don't like this voice, select another one from the **Selected Voice** drop down list and adjust the track bars until you are happy.

6. Once you have selected a suitable voice, click on the **Create** button. You will see the third window in the Speech Maker facility:

7. Browse to the folder in the directory in which you want to save the sound file, type a name for the file in the **Save As** text box.
8. The **MP3** sound file format is selected by default as this is the most popular format. This format is supported by most audio players such as MP3 players, iPods, etc.

In the File Format you can choose from MP3, M4A or AIFF.

9. Click on **Save** to create the sound file.

10. Browse to the directory where you saved the sound file and open it to hear the sound file you have just created. You will hear the text you highlighted in step 1 read aloud. This can now be played on the computer or saved onto any MP3 player or a portable media such as an iPod.

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to convert text into an audio file</td>
<td></td>
</tr>
</tbody>
</table>
7. WORKING WITH DAISY BOOKS

In this section you will learn how to:
• read Daisy books
• navigate through a Daisy book.

Exercise 1  Reading Daisy books

Before you begin this exercise, make sure you have a Daisy book saved on your computer. If you don’t have a Daisy book to work with, you can download one from the following website address: http://www.bookshare.org

1. Click on the button.
   If you cannot find this icon on your toolbar select Mode and then Reading. You see the Select a Daisy book window displayed.

2. Browse to the location in the directory where you've saved the Daisy file, select it and then click on the Open button.
   The Daisy book opens in the Daisy Reader window. An example of this is shown below:

3. Click on the appropriate Navigation button to find the text you want to read:
   • ‼️ – displays the first page in the book
   • ‼️ – displays the previous page in the book
   • ‼️ – displays the next page in the book
   • ‼️ – displays the last page in the book.

4. Click on the button on the Read&Write Mac toolbar.
5. Click on the button on Read&Write Mac toolbar to stop the system from reading the word, sentence or paragraph aloud.

6. You can also find the text that you want by accessing the:
   - Table of Contents menu
   - Bookmark menu and setting your own bookmarks so you can easily find your place again.

7. Close the Daisy Reader window.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to read a Daisy book</td>
<td></td>
</tr>
<tr>
<td>How to navigate through a Daisy book</td>
<td></td>
</tr>
</tbody>
</table>
8. PDF ALOUD

In this section you will learn how to:
- read PDF documents
- change the PDF Aloud options.

**Exercise 1  Reading PDF documents**

In this exercise you will learn how to read text aloud from PDF documents using PDF Aloud. You will also learn how to choose the colours for use during the reading of text aloud using the Preferences in Read&Write Gold for Mac.

1. Click on the PDF button and then open a PDF document.
2. The PDF document will open and look something like this:

3. Click on the button on the Read&Write Gold for Mac toolbar. PDF Aloud reads aloud the text in your document.
   
   To just have part of the text read, select the text and click .

4. Click on the button on the Read&Write Gold for Mac toolbar to stop the reading.
5. Across the top of the window is a toolbar:

6. The Current Page shows you what page you are on. You can change the page using the Previous Page and Next Page arrows.
7. Click on 🕵️‍♂️ to zoom in to your document.

8. Click on 🕵️‍♂️ to zoom out of your document.

9. The **Click and Speak** is active if the circle next to the hand is green. This means you can click somewhere specific in the document to have it read aloud.

10. You can use the **Search** to find key words in your document.

11. The **Print** button will allow you to print the document.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to have a PDF document read using PDF Aloud</td>
<td></td>
</tr>
<tr>
<td>How to alter how PDF Aloud reads</td>
<td></td>
</tr>
</tbody>
</table>
9. SPELL CHECKING

In this section you will learn how to:
- use the Spell Check
- set up general spelling options
- set up the Custom Dictionary
- add a phonetic map
- review spellings.

Type the following text into a blank Microsoft Word document:

There are deliberate spelling mistakes in the text that you must enter letter for letter to use for practice. They are underlined for locating. You do not need to underline these misspelt words in your document.

A **volcano** tends to occur where **tectronic** plates meet. The earth is made up of about 8 big **tectronic** plates. When volcanoes erupt they can throw out lava, ash and gases. An example of a volcano is Mount **Rinjani**. This volcano is found on the **iland** of Lombok. It has a long history of **eraptions** and erupted in 1994 and more recently in May 2010.

**Exercise 1 Using the Spell Checker**

1. Click on the ![button](image) button on the toolbar. You will see the **Spelling Helper** window displayed:

   ![Spelling Helper Window](image)

   The first misspelt word in your document is highlighted in red.

2. You can use the following buttons to correct your spellings:
   - **Change** button – select a word from the Word list box and then click on this button to change the misspelt word to the selected word. Use this to correct ‘volcano’ to ‘volcano’. 
• **Change All** button – select a word from the Word list box and then click on this button to change all instances of the misspelt word throughout your document. Use this to correct ‘tectronic’ to ‘tectonic’.

• **Add Custom** button – click on this button to add the selected word to your Custom Spelling Dictionary. Use this to add ‘Rinjani’ to the [Custom Dictionary](#).

• **Auto Correct** button – select a word from the Word list box and then click on this button to add the misspelt word to the auto correct file. In future, when you type the word incorrectly, the Spelling facility will now automatically change the word to the selected word. Use this to correct ‘iland’.

Correct the rest of the document.

• **Ignore** button – click on this button to ignore the misspelt word.

3. The Spelling Helper window closes and the [No Spelling Errors](#) window appears.

4. Click **OK**.

**What else can you do:**

• Changing the colour used to identify spelling errors – [Changing the colour used to identify spelling errors](#).

• Add words to the Custom Dictionary – [Adding words to the Custom Spelling Dictionary](#).

• Alter the spelling suggestions – [Adding a phonetic replacement](#).

• View your spelling log which records all the spelling mistakes you have made - [View your spelling log](#).
Further Exercises

**Exercise 2  Changing the colour used to identify Spelling Errors**

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the **Appearance** tab of the **Preferences** window:

3. Click on the **Spelling Errors Color** button and select a colour from the colour palette to specify the colour that will be used to identify all Sounds Like and Confusing words.
   
   The **Example** box shows you how it will look.

**Exercise 3  Adding words to the Custom Spelling Dictionary**

In this exercise you will learn how to add words that the spell checker does not recognize to the Custom Spelling Dictionary. (Once you have added a word, the spell checker will no longer identify it as a misspelt word.) These tend to be names of people or places.

To add words to the **Custom Spelling Dictionary**:

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the **Spelling** tab of the **Preferences** window:
3. Notice that the word ‘Rinjani’ and ‘Lombok’ are in here. These were added in the last exercise.

4. Click on the + button.

5. Type the word Bannack in the Word text box. Bannack is the name of a town and isn't recognized as being a correct word.

6. Bannack is added to the Custom spellings list box.

7. Click on the Close to save the settings and to close the Preferences.

8. This means from now on if you should ever type Bannack the Spell checker will recognise it is a correct word. You can add further words in to the Custom Dictionary in the same way if you need to.

**Exercise 4 Adding a phonetic replacement**

The Spell Check facility uses a phonetic map to make suggestions for misspelt words. Phonetic maps help the Spell Checker to find corrections for difficult spelling errors such as phonetic errors and errors caused by OCR. It uses groups of letters that sound the same or are normally confused.

For example, if you often type ‘telefone’ or ‘elefant’, Read&Write Gold for Mac will be able to use the phonetic mapping ‘f = ph’ to solve these errors.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Spelling tab of the Preferences window:
3. Click on the button.
4. Click in the word box and type in 'knowledge'.
5. Click in the Phonetic word and type in 'nolij'.
6. Click on Close to close the Preferences.
7. In a new Microsoft Word document type the following exactly:

   She was keen to improve her nolij of geography.

8. Click on the button on the toolbar. You will see the Spelling Helper window displayed with the correction for 'nolij' to 'knowledge' at the top of the list. Correct the spelling mistake.

   You can add new phonetic replacements when needed.

**Exercise 5  View your Spelling Log**

1. When you use the Spell Checker it will keep a record of all the spelling mistakes made and the corrections. To open the Spelling Log:

2. Click on the button on the Read&Write Gold for Mac Toolbar.
3. Select the Spelling tab of the Preferences window:

4. Click on Show Spelling Log.
5. The **Spelling Log** appears looking something like this:

![Spelling Log Image](image)

6. If you wish you can **Export** the log which will create a spreadsheet.

7. **Close** the Spelling Log.

8. **Close** the Preferences.

---

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Spell Check a document</td>
<td></td>
</tr>
<tr>
<td>How to use Spell as I Type</td>
<td></td>
</tr>
<tr>
<td>How to add words to the Custom Dictionary</td>
<td></td>
</tr>
<tr>
<td>How to set the spelling settings</td>
<td></td>
</tr>
<tr>
<td>How to use the auto correct</td>
<td></td>
</tr>
<tr>
<td>How to review the spelling suggestions</td>
<td></td>
</tr>
<tr>
<td>How to add a phonetic replacement</td>
<td></td>
</tr>
<tr>
<td>How to view the spelling log</td>
<td></td>
</tr>
</tbody>
</table>
10. USING THE SOUNDS LIKE AND CONFUSABLE WORDS

In this section you will learn how to:

- use the Sounds Like and ConfusableView button to identify and correct words that sound similar or which may be confused with others
- add additional confusing words
- return always ignored homophones to the list.

Type the following text into a blank Microsoft Word document:

A magma chamber is were magma from deep within the planet gathers. Pipes allow the larva too get threw to the surface.

Exercise 1 Identifying like sounding and confusable words

In this exercise you will learn how to identify like sounding words (homophones) and confusable words in your document to help you ensure you have typed the correct word.

1. Place your cursor on the text you typed in your document and then click on the button on the Read&Write Gold for Mac Toolbar.

You will see the Sounds Like & ConfusableView window:

The first homophone highlighted in this window is ‘were’.

2. Make sure the word ‘were’ is selected in the Sounds Like list box and read the definition in the Definitions list box. To hear it read aloud, click on the definition and then click on the button on the toolbar. This is not the correct word based on the context of this sentence.
3. Click on the word ‘where’ in the **Sounds Like** list box and read the definition in the **Definition** list box. To hear it read aloud, click on the definition and then click on the **button on the toolbar. This is the correct word based on the context of this sentence.

4. Click on the **Replace** button. The word ‘were’ is replaced in your document by the word ‘where’.

5. The **Same Sounding & Confusing Words** window moves on to the next homophone or confusable word in the sentence, which is ‘within’.

6. This is the correct word. Click on the **Ignore** button.

   The **Same Sounding Words** window moves on to the next homophone or confusable word, which is ‘the’.

7. This is the correct word. Click on the **Always Ignore** button. This means that the word ‘the’ and all its associated homophones will be ignored from now on.

   ![You can return words that you have decided to Always Ignore. How to do this is explained in Exercise 4 Returning Always Ignored words](image)

   The **Same Sounding Words** window moves on to the next homophone or confusable word, which is ‘larva’.

8. Select ‘lava’ from the **Sounds Like** list box as this is the correct word.

9. Click on the **Replace** button.

   The **Same Sounding Words** window moves on to the next homophone or confusable word, which is ‘too’.

10. Select ‘to’ from the **Sounds Like** list box as this is the correct word.

11. Click on the **Replace** button.

   The **Same Sounding Words** window moves on to the next homophone or confusable word, which is ‘threw’.

12. Select the word ‘through’ which is the correct word. Click on the **Replace** button.

   The **Same Sounding Words** window moves on to the next homophone or confusable word, which is ‘to’.

13. This is the correct word. Click on the **Always Ignore** button. This means that the word ‘to’ and all its associated homophones will be ignored from now on.

14. The **Sounds Like check complete** panel appears. Click **OK**.

15. Your text should now be like this:

   *A magma chamber is where magma from deep within the planet gathers. Pipes allow the lava to get through to the surface.*
What else can you do:

- Changing the colour used to identify homophones or confusing words – [Changing the colour used to identify homophones](#).
- Add other words that you get confused with – [Editing the Sounds Like and Confusable Words database](#).
- Return always ignored words to the Sounds Like and Confusable Words – [Returning Always Ignored words](#).

**Further Exercises**

**Exercise 2  Changing the colour used to identify homophones**

1. Click on the [button](#) on the Read&Write Gold for Mac Toolbar.
2. Select the **Appearance** tab of the **Preferences** window:

   ![Appearance Tab](#)

   ![Example box](#)

3. Click on the **Sounds Like Color** button and select a colour from the colour palette to specify the colour that will be used to identify all **Sounds Like and Confusing** words.

   The **Example** box shows you how it will look.

4. Close the **Preferences**.
Exercise 3  Editing the Sounds Like and Confusable Words database

In this exercise you will learn how to add a new word group to the Sounds Like and Confusable Words database.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Sounds Like tab of the Preferences window:

3. Type the word ‘primer’ in the Search text box.
   No meaning appears showing that the word does not exist in the Sounds Like and Confusable Words database.
4. Click on the button.
   ‘primer’ is displayed in the Create Sounds Like Entry Panel.
5. Click on the Definition text box and type ‘an elementary textbook’ and then click Save.
6. Click on the button again.
7. Type the word ‘primmer’ in the Word text box.
8. Click on the Definition text box and type ‘more prim; very proper’ in the Definition text box and then click Save.
9. Click on the Close button to save your settings and to close the Preferences window.

The words ‘primer’ and ‘primmer’ are now added to the Sounds Like and Confusable Words database.
Exercise 4  Returning Always Ignored words

In Exercise 1 words were excluded from the Sounds Like and Confusable words feature using the Always Ignore button. You may wish to add these words back. To do this:

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Sounds Like tab of the Preferences window:

![Sounds Like Tab](image1)

3. The words ‘the’ and ‘to’ are in the Ignored Words list box.

4. Click on the word ‘the’ and then on the button. This removes ‘the’ from the list.

5. Click on the word ‘to’ and then the button. ‘to’ is removed from the list.

6. Now the words ‘the’ and ‘to’ will be checked.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to identify same sounding and confusing words</td>
<td></td>
</tr>
<tr>
<td>How to change the colour used to identify same sounding and confusing words</td>
<td></td>
</tr>
<tr>
<td>How to add additional confusing words</td>
<td></td>
</tr>
<tr>
<td>How to return Always Ignored words</td>
<td></td>
</tr>
</tbody>
</table>
11. PREDICTING TEXT

In this section you will learn how to:
- use the Prediction facility
- specify how you want the Prediction facility to learn.

**Exercise 1 Using the Prediction facility**

In this exercise you will learn how to use Word Prediction to help you finish sentences. It will access a list of words that will complete the one that you are currently typing and will also try to predict your next word as you are typing a word.

1. Open a new blank document in Microsoft Word and then click on the button on the toolbar to display the Prediction window.

2. Type the following text into your document and notice how the Prediction window is predicting words for you to use:

   This is an ex

3. When you type in the ‘ex’ you will see a list of words beginning with ‘ex’ displayed in the Prediction window.

4. Click on ‘example’ in the Prediction window.

5. Click on the button.

6. You will see the Dictionary displayed looking something like this:

   ![Dictionary Window](image)

   You can read the definition and decide if it is the word for which you are looking. Close the Dictionary window.

7. Double click on ‘example’ to put the word into your document.
9. Use the **Word Prediction** to write a few sentences and watch how the word box provides suggestions.

10. Close **Prediction** by clicking on the button.

**What else can you do:**
- Add words to the prediction – [Adding your own Word Banks](#).

---

**Further Exercises**

### Exercise 2 Adding your own Word Banks

In this exercise you will learn how to get Prediction to learn vocabulary so that the words predicted are more tailored to your needs.

1. Type the following text into your document or select some text from one of your documents:

   **A volcano is a geological landform on the surface of the earth (and other planets) where magma from the planet's interior erupts (or once erupted) to the surface. Roughly defined, a volcano consists of a magma chamber, pipes and vents.**

2. Copy the text and then click on the button on the Read&Write Gold for Mac Toolbar.

3. Select the **Prediction** tab of the **Preferences**:

4. Click on the button.

5. A panel will appear with the words you had copied.

6. Click **OK.**
7. You will be asked to save the file.

8. Type the following details:
   - Save As – Volcano (if you have used your own text put in a file name relevant to it)

9. Click on Save.


11. In a Word document start to type some of the words that you have just added and notice how the prediction is predicting words based on that text.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use Word Prediction</td>
<td></td>
</tr>
<tr>
<td>How to teach the Word Prediction new vocabulary</td>
<td></td>
</tr>
</tbody>
</table>
12. USING THE DICTIONARIES

In this section you will learn how to:
- find basic and advanced definitions
- find web definitions
- add your own definitions to the Dictionary
- find graphical representations of words using the Picture Dictionary.

Type the following text onto a new line in your document:

The earth revolves around the sun.

Exercise 1  Using the Dictionary

In this exercise you will learn how to use the Dictionary to find basic and advanced definitions.
1. Highlight the word ‘earth’.
2. Click on the button on the Read&Write Gold for Mac Toolbar.
   You will see the Dictionary window displayed:

   The definitions of the word ‘earth’ are displayed in the Meanings list box.
3. Click on the first definition and then click on the button to hear it read aloud.
Exercise 2  Using the alternative searches

You can find alternative related words using the advanced searches:

1. With the word ‘earth’ in the **Original Word** text box. Click on **Part of these**.
2. You will see two definitions provided. Click on the definition that begins with ‘**The 3rd planet from the sun**...’
3. Click on the word ‘world’ in the **Advanced** list box and then click on the **button** to hear it read aloud.
4. Click on the **button** to replace the word ‘earth’ with the word ‘world’ in your text.

Exercise 3  Searching for web definitions

In this exercise you will learn how to use Read&Write Gold for Mac to find definitions on the Internet.

1. Click on the **button** on the Read&Write Gold for Mac Toolbar.
2. Select the **Dictionary** tab of the **Preferences**:

3. Click into the **Use Web Dictionary** option to turn this on. **Close** the Preferences.
4. Select the word ‘world’ in your text.
5. Click on the **button** on the Read&Write Gold for Mac Toolbar. Your browser window automatically opens and displays the Google dictionary. You will see a list of definitions for the word ‘world’.
6. Close your browser when you have finished viewing this page.
Exercise 4 Using the Picture Dictionary

In this exercise you will learn how to use the Picture Dictionary to find pictorial/symbolic representations of words.

⚠️ You must be online in order to use the Picture Dictionary.

1. Highlight the word ‘world’ and then click on the button.
   You will see the Picture Dictionary window displayed:

2. Highlight the word ‘revolve’ in your document.
   The Picture Dictionary window displays a picture representing the word revolve.

3. Click on the button and the Dictionary will open with the text definition for the word revolve.
4. Close the Picture Dictionary when not in use.

What else can you do:
- Add your own words to the Dictionary – Adding user definitions.
Further Exercises

Exercise 5  Adding user definitions

In this exercise you will learn how to add your own definitions to the Dictionary.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Dictionary tab of the Preferences:

![Diagram of the Preferences window]

You can use this tab to enter new words plus their definitions which may not be in the Dictionary, e.g. a slang word. To do this:

3. Enter the word in the Word text box.
4. Enter the definition of the word in the Definition text box.
5. Click on the button.

The word is added to the List of custom words.
6. Click on the Close button to save your settings and to close the Preferences.
7. Try accessing the Dictionary to find the word and its meaning.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Dictionary</td>
<td></td>
</tr>
<tr>
<td>How to find alternative words</td>
<td></td>
</tr>
<tr>
<td>How to use the Web Dictionary</td>
<td></td>
</tr>
<tr>
<td>How to use the Picture Dictionary</td>
<td></td>
</tr>
<tr>
<td>How to add your own words to the Dictionary</td>
<td></td>
</tr>
</tbody>
</table>
13. USING THE VERB CHECKER

In this section you will learn how to:

- use the Verb Checker

Type the following text into a Microsoft Word document:

I seen a volcano erupt.

Exercise 1 Using the Verb Checker

In this exercise you will learn how to use the Verb Checker to search for verb conjugations of the word ‘seen’ so that you can use them to write sentences (in different tenses) in your document.

1. Place your cursor on the word ‘seen’ in your document.

2. Click on the button on the Read&Write Gold for Mac Toolbar. You will see the Verb Checker window displayed:

3. Click on the Next button. You will see the second step of the Verb Checker displayed:
4. Select the ‘Is this in the past?’ radio button and then click on the **Next** button. You will see the third step of the **Verb Checker** displayed:

The verb is shown in sentence format preceded by different personal pronouns, i.e.
I, you (singular), he, she, we, you (plural) and they. Variations of these sentences are shown in the past tense.

5. Place your cursor in the sentence ‘I saw’ in the **Past** list box.

6. Click on the **button on the toolbar to hear the sentence read aloud.

7. Click on the **Replace** button.
   The Verb Checker replaces the word in your document with the past tense of the word.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Verb Checker</td>
<td></td>
</tr>
</tbody>
</table>
14. USING THE SCANNING FACILITY

In this section you will learn how to use the Scanning facility to:

- perform a scan
- scan multiple documents
- scan from a file

To complete this section, you must ensure that you’ve set up your scanner correctly and have two documents ready to scan.

Read&Write Gold for Mac uses your default scanner.

Exercise 1  Performing a Scan

In this exercise you will learn how to perform a scan. A scan allows you to scan directly into a PDF, MS Word or HTML document. This exercise will show you how to scan to PDF and to MS Word.

1. Place a page into your scanner and then click on the button on the Read&Write Gold for Mac Toolbar.
2. The Scanning Options will appear:

![Scanning Options](image)

3. Make sure the following options are selected:
   - Your scanner
   - Mode - Single Page
   - Output options - PDF.
4. Click on **Scan**.
5. Complete the **Save As** panel and then click **Save**.
6. The Scanning facility scans your document. When the scan has completed, you will see the scanned image displayed in PDF Aloud. You can use PDF Aloud to read the document. This type of scan is recommended if you simply wish to scan a document and have it read. Scanning into PDF provides a ‘near’ picture image of the original document.

7. Click on the button on the Read&Write Gold for Mac Toolbar.
8. The **Scanning Options** will appear:

![Scanning Options](image)

9. Make sure the following options are selected:
   - **Your scanner**
   - **Mode - Single Page**
   - **Output options - Word**.

10. Click on **Scan**.
11. Complete the **Save As** panel and then click **Save**.

   The Scanning facility scans your document. When the scan has completed, you will see the scanned image displayed in Microsoft Word.

   Scanning to Word is recommended if you want to edit the scanned document.

   ![You can also Scan to HTML. This opens the scanned image in your browser.](image)
Exercise 2  Scanning multiple documents

In this exercise you will learn how to scan multiple documents.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. The Scanning Options will appear:

![Scanning Options](image)

3. Make sure the following options are selected:
   - Your scanner
   - Mode – Multi-Page
   - Output options - Word.
4. Click on Scan.
5. The Scanning in progress panel appears.
6. Once this panel disappears place the next page in the scanner and click on Scan Next Page.
7. The Scanning in progress panel appears.
8. When this disappears click on Finish Scanning.
9. Complete the Save As panel and then click Save.
10. Once the scan is complete the scanned document will appear in Microsoft Word.
Exercise 3  Scanning from a file

You can also scan from a saved image file on your computer. So for example you could take a picture of a page of a book, or a poster and have it scanned.

For this exercise, make sure that you have an image file or PDF with multiple pages stored on your computer.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. The Scanning Options will appear:

   ![Scanning Options](image)

3. Make sure the following options are selected:
   - Scan from file
   - Mode - Multiple Page
   - Output options - Word.
4. Click on Scan Next Page.
5. Browse to the location where you have stored your image or PDF.
6. Select the image or PDF and then click on the Open button.
7. A dialog box is displayed asking you to enter a range of pages you would like to scan. Enter ‘1-2’ in the text box provided.
8. Click on Scan.
9. After the Scanning in Progress panel disappears click on Finish Scanning.
10. Complete the Save As panel and then click Save. The image is scanned and opened in Microsoft Word.
11. Click Cancel to close the Scanning Options.
## Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to scan to PDF, MS Word or HTML</td>
<td></td>
</tr>
<tr>
<td>How to scan single pages</td>
<td></td>
</tr>
<tr>
<td>How to scan multiple pages</td>
<td></td>
</tr>
<tr>
<td>How to scan from a file</td>
<td></td>
</tr>
</tbody>
</table>
15. USING THE FACT FINDER

In this section you will learn how to use the Fact Finder to:

- search for information on the Internet
- change the default website.

Type the following text into a Microsoft Word document:

Volcanoes tend to occur where tectonic plates meet.

**Exercise 1 Searching for facts using the Fact Finder**

In this exercise you will learn how to search for facts using the Fact Finder.

1. Highlight the word ‘volcanoes’ in your text.

2. Click on the button.

   If you can’t see it on the toolbar click on **Mode** and select **Research**.

   Your browser window opens displaying the search results for ‘volcanoes’ in Google.com.

**What else can you do:**

- Change the default search engine – Changing the default website to search for facts.
Further Exercises

Exercise 2  Changing the default website to search for facts

In this exercise you will learn how to change the default website and search for facts using this website.

1. Click on the button on the Read&Write Gold for Mac Toolbar.
2. Select the Fact Finder tab of the Preferences:

3. Choose one of the other search engines and then click Close.
4. Highlight the word ‘volcanoes’ again and click on the button.
5. Your browser opens showing the result in the search engine you had chosen.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Fact Finder</td>
<td></td>
</tr>
<tr>
<td>How to add additional search engines</td>
<td></td>
</tr>
</tbody>
</table>
16. USING THE FACT FOLDER

In this section you will learn how to:
- add text facts
- add images
- change fact details and properties
- export facts.

The Fact Folder is used mainly to collect facts from the Internet.

**Exercise 1 Adding text facts**

In this exercise you will learn how to use the Fact Folder to save a paragraph of text as a new fact.


2. Choose one of the results and click on the link.

3. On the webpage highlight some interesting information and then click on the button and then select Add Fact.

4. The Fact Details window is displayed.

5. Type the word ‘Volcano’ into the Title text box.

6. Type the name of the author in the Author text box. If there is none given, type ‘Unknown’.

   The locations and URLs of any documents and websites that are open are displayed in the Sources list box.

6. There will be a tick in the check box beside the location of the website you have collected the text from.

7. Click on the button under the Category. You will see the Select Categories window displayed:
8. Click on the [+] button and type the text ‘Geography’ in the <Enter Title Here>. Press Return on your keyboard.

9. With Geography, selected click on the OK button to add the new Geography category.

10. In the Description text box, type something to explain what the fact is about.

11. Click on the Close button.

**Exercise 2 Adding images**

In this exercise you will learn how to use the Fact Folder to save an image from a web page.

1. Find a picture of a volcano on the Internet. Then click on the button and select the Add Image Fact option. You will see the Add Image panel appear:

2. Drag and drop the image of a volcano into the Add Image panel.

3. Click on Add. You will see the Fact Details window displayed.

4. Type the text ‘Volcano picture’ into the Title text box.
5. Type the name of the author of the photo if available in the Author text box. If it is not, type ‘Unknown’.

6. The check box beside the URL which contains the image you have just selected will have automatically been selected.

7. Click on the button beside the Categories text box. You will see the Select Categories window displayed.

8. Select Geography in the Category List and then click on the OK button.

9. Enter the text ‘Picture of a volcano’ in the Description text box and then click on the Close button.

Exercise 3  Changing fact details and properties

In this exercise you will learn how to change the details of facts that you have already added to the Fact Folder. You will also learn how to update fact content.

1. Click on the button and select Review Facts.

2. The Fact Folder window opens and will look something like this:

3. Click on the ‘Volcano picture’ fact in the Fact Folder window. You will see a preview of the image in the Source Content panel.

4. Click on the button. You will see the Fact Details window displayed.

5. Type the text ‘Also lists other useful information’ in the Description text box and then click on the Close button. The description is updated in the Fact Folder window.

6. Click on the ‘Volcano’ fact and then click on the button. You will see the Displaying Fact window.
7. Add the text ‘Volcanoes tend to occur near tectonic plates’ to the text that is already there.

8. Click on the Close button.

9. Close the Fact Folder window.

**Exercise 4  **Exporting facts from the Fact Folder

In this exercise, you will learn how to export facts to a Microsoft Word document.

1. Click on the button and select the Review Facts option. The Fact Folder window opens:

![Fact Folder window](image)

2. In the Fact Folder window, select Geography from the category drop down list. This will ensure that only the facts you have added to this category are displayed.

3. Select the Fact check boxes beside the 2 facts you recently added.

4. Click on the button.

You will see the Export to window displayed.

5. Select the Harvard option from the Bibliography Format drop down list and then click the button. Close the Fact Folder window.

Read&Write Gold for Mac automatically creates the Microsoft Word document and lists all of the facts for the Volcano category. The bibliographical information for a bibliography in the Harvard style is also included.

6. After you have viewed your new Microsoft Word document, you may save and close it.
# Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to add text</td>
<td></td>
</tr>
<tr>
<td>How to add images</td>
<td></td>
</tr>
<tr>
<td>How to change fact details and properties</td>
<td></td>
</tr>
<tr>
<td>How to export facts</td>
<td></td>
</tr>
</tbody>
</table>
17. USING THE FACT MAPPER

In this section you will learn how to:
- create fact maps
- open fact maps and add notes to facts
- use the Image Library to add images to a map
- link facts
- change how a fact map is displayed
- brainstorm
- export fact maps

You use the Fact Mapper, which is an online graphical user interface, to add different types of facts to a Fact Map. You can then link each of the facts to each other to represent a relationship between them. This enables you to create a diagram of your ideas and information on a subject and therefore help you understand and remember it better.

Note that changing the Theme colour once you have begun work on your Fact Map will cause you to lose your work.

Exercise 1 Working with the Fact Mapper

1. To access the Fact Mapper, click on the button on the Read&Write Gold for Mac Toolbar. You see the Fact Mapper window displayed:

2. Click on the green option on the Theme palette:
   Wait a few moments the colour of the window changes to green.
3. Change the window back to the original blue colour, i.e. the first colour on the Theme palette, or select the colour of your choice.
4. Click on the **File** menu in order to view the **File** toolbar:

![File toolbar]

5. Click on the **Fact Map** menu in order to view the **Fact Map** toolbar:

![Fact Map toolbar]

6. Click on the **File** menu in order to view the **File** toolbar again:

- When working with Fact Maps, make sure you **save before** closing the Fact Mapper or you will lose your work.
- Click on the and buttons at the top right-hand-side of the **Fact Mapper** window to select the zoom level at which you want to view the Fact Map.

Exercise 2  Creating fact maps

In this exercise, you will learn how to create a Fact Map and add facts.

1. Click on the button on the Fact Map toolbar.
   A new fact is displayed in the main work area.
2. Type the text ‘America’ into the new fact:

![America fact]

3. Click on the America fact and then click on the button.
   A new fact is displayed in the main work area and is linked to the first fact.
4. Type the text ‘Map of America’ into the new fact.
5. Add the following facts to the **Fact Map** using the same process:
   - Make sure that you click on the America fact before you add them.

   ![Fact Map]

   You may need to drag and drop the last fact onto a different position on the Fact Map to ensure that you can easily see that it is coming from the America fact.
   - **United States of America**
   - **American states**
   - **Flag**
The Fact Map should look something like this:

6. Select the 'Flag' fact and then click on the button. This fact is removed from the Fact Map.

7. Select the 'American States' fact then click on the button.

8. Change the name of the fact to the following: '50 states'.

Exercise 3  Adding notes to facts

In this exercise, you will learn how to add notes to facts.

1. Select the 'American States' fact.

2. Type the following text into the Note area at the bottom of the Fact Mapper window:
   ‘There are 50 states in the USA’.
3. Click on the button. The note is added to the fact. It is represented by the icon.

4. Select the ‘United States of America’ fact.

5. Type the following text into the text area at the bottom of the Fact Mapper window:
   ‘The motto for the USA is ‘In God We Trust’.

6. Click on the button. The note is added to the fact.

7. Select the ‘American States’ fact and then click on the button at the bottom of the Fact Mapper window. The note is removed from the fact.

Exercise 4  Using the Image Library

In this exercise, you will learn how to add images from the Image Library to your Fact Map. You will also learn how to add your own custom images for use in Fact Maps.

1. Type ‘America’ in the Search textbox at the bottom right-hand-side of the Fact Mapper window.

2. Click on the Go button. The Search tab expands to display the list of images that match your search word.

3. Click and hold down your left mouse button on the American Coin image and drag and drop it onto the ‘America’ fact in the Fact Map:

   If you find it difficult to drag and drop images, you can right-click on an image and select Copy Image, then select a fact in the Fact Map and click on the button (on the Fact Map menu).

4. Click and hold down your left mouse button on the American Football image and drag and drop it onto the ‘50 States’ fact in the Fact Map:

5. Right-click on the ‘50 states’ fact and select Restore Default Image from the popup menu.

6. Click on the button on the Search tab.
7. Click on the drop down list of image categories and select the **Classic Tourism** option.

8. Click and hold down your left mouse button on the Statue of Liberty image and drag and drop it onto the ‘50 states’ fact in the Fact Map:

![50 states](image)

### Exercise 5  Adding your own images

In this exercise you will learn how to add your own images to the Image Library so you can use them in your Fact Mapper.

1. Click on the button (on the **File** menu).
   You see a new browser window displayed.

2. Click on the button (on the **Image** menu). The **Add Images** window is displayed.

3. Enter ‘My Image’ in the text box provided.

4. Click on the **Browse** button. The **Select file to upload by factmapper.texthelp.com** window is displayed.

5. Browse to the location in your directory where you store your images.

6. Click on an image and then click **Choose**. Then click **OK**.
   The selected image is shown in the **Fact Mapper** window.

7. Click on **Close**.

8. In the Search tab, select the **Custom** option from the **Category** drop down list.

9. The image you uploaded is listed. You can now add this to your Fact Maps.

   ![Tip](image) You should make sure that your images are named appropriately to allow you to search for them more easily.

### Exercise 6  Linking facts

In this exercise, you will learn how to remove links between facts and create them again.

1. Click on the ‘Map of America’ fact and then click on the button (on the **Fact Map** menu). The fact is highlighted in blue to show that it has been selected.

2. Click on the ‘America’ fact.
   The link between the two facts is removed.

3. Repeat this process to remove the remaining links from the Fact Map:
   - **United States of America**
   - **50 states**
To reinsert the links:

4. Click on the ‘America’ fact and then click on the button (on the Fact Map menu). The fact is highlighted in blue to show that it has been selected.
5. Click on the ‘Map of America’ fact.
   You now see a line linking the two facts.
6. Repeat this process to link the remaining facts to the ‘America’ fact.

Exercise 7  Changing how a Fact Map is displayed

In this exercise you will learn how to specify how you want your Fact Map displayed.

1. Click on the drop down list (on the Fact Map menu) and select the Document Outline option. Your Fact Map is now displayed in a bulleted list.
2. Click on the drop down list again and select the Tree option. Your Fact Map is now displayed in a tree view.
3. Change it back to the way it was originally by selecting the Fact Map option from the drop down list.
4. Select ‘America’ in your Fact Map and then click on the button. You see the Arrange Facts window displayed:

You were asked to select ‘America’ because it is the category to which all of the facts are linked.

5. Select the Bottom Up Tree arrangement and then click on the OK button.

The description of each arrangement will help you decide which one you want to use in future.

The facts in your Fact Map are rearranged so that the American flag is displayed at the bottom and all the other facts are displayed above.
Exercise 8 Brainstorming

In this exercise you will learn how to use the Fact Mapper to brainstorm. This will entail adding several American states to a Fact Map as quickly as possible.

1. Click on the button (on the File menu).
   A blank Fact Map is opened in the Fact Mapper window and the Fact Map menu is displayed at the top.

2. Click on the button.
   A new fact is displayed in the main work area.

3. Type the text ‘American states’ into the new fact:

4. Make sure the ‘American states’ fact is selected and then click on the button. A new fact is displayed on top of the ‘American states’ fact.

5. Type the text ‘Arizona’ into the new fact and then press Enter. Another fact is added to the work area and is automatically linked to the first fact.

6. Add the following facts using the same process:
   - Alabama
   - Georgia.

7. Click on a blank area on the fact map to stop using brainstorming. Your Fact Map should look something like this:

8. If you wish to add more states, click on the button or the button.
Exercise 9  Exporting fact maps

In this exercise you will learn how to export a Fact Map to a Microsoft Word document.

1. Click on the button (on the File menu).
   The Fact Map is saved to your Downloads folder. It is called WordOutlineExport.doc and is given the next sequential number, e.g. 1,2,3.

   You can also export a Fact Map to Microsoft Word or to an HTML page by clicking on the File menu on the left-hand-side of the File toolbar and selecting Export. The Export Facts - Webpage window allows you to select the option you prefer.

Exercise 10  Printing, Saving and Opening Fact Maps

In this exercise you will learn how to print, save and open a Fact Map.

1. Click on the button (on the File menu).
   You will see the Print window displayed. Select your preferred print options and then click on the Print button.

2. Click on the File menu and then click on the button. You will see the File Download window.

3. Click on the Save As. The Save As window is displayed.

4. Browse to the folder in the directory in which you want to save the Fact Map. Type the name ‘America’ in the File name text box and then click on the Save button.

5. The Download complete window is displayed.

6. Close the Download window.

   Any time you need to save the Fact Map in future, you will have to override the file you just saved.

7. Click on the File menu and select the Exit option:

8. Click on the Yes button when you are asked to confirm the closure of the window.
9. Click on the button and allow access.

10. Click on the menu and then the button.

11. Click OK.

   You will see the **Open File** window displayed:

   ![Open File Window](image)

12. Click on the **Browse** button.

   You will see the Choose file window displayed.

13. Locate the America Fact Map and then click on the **Open** button.

   You will see the **Open File** window re-displayed.

14. Click on the **OK** button.

15. The America Fact Map opens in the **Fact Mapper** window.

16. Close all open maps. You do not have to save them.

### Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to create a Fact Map</td>
<td></td>
</tr>
<tr>
<td>How to add notes</td>
<td></td>
</tr>
<tr>
<td>How to add images from the Image Library</td>
<td></td>
</tr>
<tr>
<td>How to link facts</td>
<td></td>
</tr>
<tr>
<td>How to change how the fact map is displayed</td>
<td></td>
</tr>
<tr>
<td>How to brainstorm</td>
<td></td>
</tr>
<tr>
<td>How to export the Fact Map</td>
<td></td>
</tr>
<tr>
<td>How to print, save and open a Fact Map</td>
<td></td>
</tr>
</tbody>
</table>
18. USING SCREEN MASKING

In this section you will learn how to:

- use Screen Masking
- change display options when using Screen Masking
- use the spotlight.

**Exercise 1  Using Screen Masking**

In this exercise you will learn how to use the Screen Masking.

1. Click on the button on the Read&Write Gold for Mac toolbar.
   The screen is tinted blue.

2. Click on the button on the Read&Write Gold for Mac toolbar.
   The screen is returned to its normal colour.

**Exercise 2  Changing the display options**

In this exercise you will learn how to change the colours and masking type used by Screen Masking.

1. Click on the button on the Read&Write Gold for Mac toolbar. You see the Preferences window displayed.
2. Click on the Screen Masking tab:

   ![Screen Masking Tab]

3. Select the Underline My Mouse Pointer option.
4. Select a colour from the Masking Color palette.
5. Adjust the Transparent/Opaque track bar until you have selected a more opaque colour, i.e. move the scale more to the right.
6. Adjust the Thin underline/Thick underline track bar until you are happy with it.
7. Click on the Close button.
8. Click on the button on the Read&Write Gold for Mac toolbar.
9. Move your mouse up and down the screen and notice how the underline follows.

10. Click on the button on the Read&Write Gold for Mac toolbar. The screen is returned to its normal colour.

**Exercise 3 Using the spotlight**

In this exercise you will learn how to use the spotlight.

1. Click on the button on the Read&Write Gold for Mac toolbar. You see the Preferences window displayed.
2. Click on the Screen Masking tab:

3. Select the Tint my Whole Screen option.
4. Select a colour from the Masking Color palette.
5. Adjust the Transparent/Opaque track bar until you have selected a more transparent colour, i.e. move the scale more to the left.
6. Make sure the Use the Mouse Spotlight when tinting the whole screen check box is selected.
7. Make the spotlight larger by moving the Height of mouse spotlight track bar more to the right - Thick.
8. Click on the Close button.
9. Click on the button.
10. Move your mouse across the screen and notice how the spotlight works.
11. Click on the button to disable the facility when you have finished.
## Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Screen Masking</td>
<td></td>
</tr>
<tr>
<td>How to change the Screen Masking options</td>
<td></td>
</tr>
<tr>
<td>How to use the spotlight</td>
<td></td>
</tr>
</tbody>
</table>
19. USING THE TRANSLATOR

In this section you will learn how to:

- translate single English words into another language
- translate phrases, sentences or paragraphs of text into another language
- configure the Translator.

Type the following text into a blank Microsoft Word document:

A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases.

⚠️ You must be online in order to use the Paragraph Translator facility.

Exercise 1  Translating single English words into another language

In this exercise you will learn how to translate words from English into another language.

1. Select the word ‘volcano’ in your document.

2. Click on the button on the toolbar.

   The Language options are displayed:

   ![Language options](image)

   This is where you can choose which language to translate from and to. Leave it translating to French.

3. Click on Translate.

4. You will see the Online Translator window displayed:
5. Hover your mouse over the French translations to hear them read aloud.
6. Close the **Online Translator** window.

**Exercise 2  Translating paragraphs of text into another language**

In this exercise you will learn how to translate paragraphs of text from English into another language.

1. Highlight the following paragraph in your document:

   A volcano tends to occur where tectonic plates meet. The earth is made up of about 8 big tectonic plates. When volcanoes erupt they can throw out lava, ash and gases.

2. Click on the **button** on the toolbar.
   The **Language** options are displayed:

3. Click on **Translate**.
   You will see the Read&Write Paragraph Translator in a new browser window. A translation is shown in French.
4. Hover your mouse over the translated text and then click on the button to hear it read aloud.
5. Close the browser window.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to translate a single word</td>
<td></td>
</tr>
<tr>
<td>How to translate a paragraph</td>
<td></td>
</tr>
</tbody>
</table>
20. USING STUDY SKILLS HIGHLIGHTERS

In this section you will learn how to:

- collect text from a webpage or a Word document.

You can use Study Skills highlighters to highlight pieces of text which you may find of interest within a Microsoft Word document, Safari, Firefox, Chrome or Google Docs and collate the highlighted text into a new document.

To access all the Study Skills Highlighters, click on the **Mode** and select **Study Skills**.

**Exercise 1  Collecting text for your studies**

In this exercise you will learn how to collect different types of text and then insert them into a new document.

1. Open your Internet browser window and then open one of your favourite websites.

   Alternatively, open a Microsoft Word document of your choice.

2. Highlight some text on the page and then click on the **(Highlight green)** button.

   Read&Write Gold for Mac highlights the text in green. An example is shown below:

3. Highlight some more text on this page and then click on the **(Highlight pink)** button.

   Read&Write Gold for Mac highlights the text in pink.

4. Repeat step 3 to highlight two further separate paragraphs in pink.

5. Highlight some of the text in pink and then click on the **(Clear highlights)** button.

   Read&Write Gold for Mac de-selects the highlighted text in pink.

   **Be careful using the Clear Highlights on websites as it will clear ALL of your highlights!**

6. Highlight some text on the page and then click on the **(Highlight blue)** button.

   Read&Write Gold for Mac highlights the text in blue.

7. Click on the **(Collect highlights)** button.
The Collect Highlights window is displayed:

![Collect Highlights Window]

8. Make sure the following options are selected:
   - the New Line option is selected from the Separate Items By drop down list
   - the New line option is selected from the Separate Colors By drop down list

9. Click on the Collect button.

Read&Write Gold for Mac collects the highlighted text from the webpage or Word document and inserts it into a new Microsoft Word document.

10. Save your document and call it My Studies.


Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>✔️</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to collect text using Study Skills Highlighters</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
21. VOCABULARY

In this section you will learn how to:

- create a Vocabulary List

Exercise 1  Creating a vocabulary list for your studies

In this exercise you will learn how to add words to a Vocabulary List which you can use for your studies. A Vocabulary List provides definitions and explanatory images for your selected words.

1. Open a Microsoft Word document of your choice.

2. Highlight a word on the page and then click on the (Highlight green) button. Repeat this step until you have highlighted several words.

3. Click on the button on the toolbar.
You will see the Vocabulary window displayed:

Your selected words are listed in the Vocabulary List box.

4. Type ‘world’ in the Add new word to list text box and then click on the Add button to add the word to the Vocabulary List box.

5. Type ‘My text’ in the Subject/Title text box.
6. Make sure the Include images checkbox is selected.

You will need to be online to view the images in the Vocabulary List.

7. Click on the OK button.

Your Vocabulary List is displayed in Microsoft Word, complete with definitions and explanatory images:
8. Type the following text in the **Notes** column for the word ‘earth’:

   ‘What we live on’.

9. Save your document and call it ‘My Vocabulary List’.

**Learning Check List**

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>☑</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to create a Vocabulary List</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
22. USING THE CALCULATORS

In this section you will learn how to:

- use the Calculator

Exercise 1  Using the Standard Calculator

In this exercise, you will learn how to use the Calculator.

The Calculator is not on the default toolbar. You will need to add the icon using the View - Customize Toolbar option.

1. Click on the button.

You will see the Calculator window displayed:

2. Click on the following buttons: 5 + 9 + 4 =

The system calculates the sum for you.

3. Click on the C (clear all values) button. To clear the sum.

4. Close the Calculator.

Learning Check List

<table>
<thead>
<tr>
<th>Learning Outcome</th>
<th>Benefit/Suggested use</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to use the Calculator</td>
<td></td>
</tr>
</tbody>
</table>